Version 9.2

SmartPTT PLUS
Capacity Max Configuration Guide



http://smartptt.com/
http://smartptt.com/

Contents

Contents

1 Capacity Max

1.1 Configuring Capacity Max

1.2 Configuring Trunk Controller

1.3 Configuring MNIS Data Gateway

1.4 Configuring MNIS VRC Gateway

1.5 Configuring Talkgroups

1.6 Security Settings

1.7 Adding Console in Radio Management

1.8 Configuring Joint GPS and Indoor Data
1.8.1 Configuring Capacity Max in Radio Management
1.8.2 Configuring Repeater in Radio Management
1.8.3 Configuring Radio in Radio Management
1.8.4 Configuring Radio in SmartPTT Dispatcher

15
22
26
27
37
38
39
39
40
40

SmartPTT PLUS

Capacity Max Configuration Guide



Capacity Max 3

Capacity Max

Capacity Max is a trunking MOTOTRBO system that supports the European Telecommunications
Standards Institute (ETSI) Digital Mobile Radio (DMR) Tier III operation.

Capacity Max system represents the enhancement of the Linked Capacity Plus functionality. It can
include up to 15 sites and up to 15 trunked repeaters with up to 3,000 users per site. One slot on
each site is allocated as a control channel. Capacity Max also supports data revert repeaters: up to
6 per site and 12 time channels per site.

Capacity Max system supports connection by using control stations. The parameters of the control
station correspond to the parameters of an ordinary MOTOTRBO control station.

Capacity Max system offers the simple and efficient system architecture that utilizes standard
Internet protocol (IP) network with a centralized Capacity Max System Server (CMSS).

£} wnisData IP Network
{3 Gateway
SmartPTT ESX Server
Radioserver Gapacity Max System Server

NISVRG| | Trunking
Gateway Controller

IP Network

SmartPTT SmartPTT SmartPTT
Dispatcher Dispatcher Dispatcher
Console Console Console

CMSS represents the VMware Sphere version 5.5 ESX server and includes the following virtual
resources:

* Trunking Controller based on the Red Hat Linux

* MNIS VRC gateway
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* Radio Management application that is used instead of MOTOTRBO Customer Programming
Software (MOTOTRBO CPS) to configure the system

The system architecture also includes the MNIS Data Gateway, which is installed separately.

* High security. All voice, data and control traffic within the IP network is encrypted, and all
radios are securely authenticated

* High level of reliability and resilience. The system can include an optional redundant server
in addition to the main server and up to three alternate control channels per site

Capacity Max is compatible with all MOTOTRBO repeaters, except DR3000 series with the 8MB
RAM, and all MOTOTRBO 4000 series portable and/or mobile radio stations.

To configure the Capacity Max system in SmartPTT Radioserver Configurator, you should have the
following programs installed:

* Radio Management - to get the settings of the preconfigured virtual resources

«  MOTOTRBO Network Interface Service Configuration Utility - to set up the MNIS Data
Gateway

Capacity Max configuration in SmartPTT Radioserver Configurator includes the following steps:
* Adding a new network and performing its basic configuration
+ Configuring a Trunking Controller
+ Configuring MNIS Data Gateway settings for data transfer
+ Configuring MNIS VRC Gateway settings and talkgroups

+ Configuring security settings
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1.1 Configuring Capacity Max

To connect a new Capacity Max system to the SmartPTT Radioserver, follow these steps:

1. Onthe Networks tab, right-click Capacity Max Networks and then click Add.

Settings Metworks  Client List Rules  Activity Log

BExport/Import Settings  Statistics

@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadicService.exe.config - O X

ﬁ;_ Control Stations

----- w Connect Plus

W NAl Systems

----- g SIP/RTF Interfaces Add

Capacity Max Networks

2. Select the created Capacity Max system. The Capacity Max System pane appears:

Settings Metworks  (Client List  Rules  Activity Log

@ SmartPTT Server Configuration - C\Program Files (x88)\5martPTT\Server\RadioService.exe.config — O et

Export/Import Settings  Statistics

g Control Stations

ﬁ Connect Plus

-y MNAI Systems

-y Capacity Max Networks

=W™=1 Capacity Max 1
Trunking Controller

i@l MNIS Data Gateway
Elh- MMIS VRC Gateway=
h MMIS VRC Gateway 1
----- Talkgroups

i./Zh Security Settings

ﬁ SIP/RTP Interfaces

- SmartPTT Radioservers

Capacity Max System
Active

MName: |Capau:'rt)r Mz 1

Interface: Ay
Trunking Contraller
MMIS Data Gateway

MNI5 VRC Gateways

Data Transmigsion Options

GPS transmission mode:

Voice Transmission Options

[] Allow transmit intemupt

[] Pricritize calls during emergency
[] Encrypted connection

Channel Grart Waiting timer (s):

TX time-out timer (z):

Data e

15 =
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3. Inthe Capacity Max System pane, configure the available options:
Name: Name of the created system.

Network ID: Unique ID of the network. The network ID must not match any ID of other SmartPTT
Radioserver networks

Radio ID: The identifier of the radioserver. This identifier is displayed on a radio when it receives
private calls and text messages from the dispatcher. If there are several dispatchers, you can
create a profile for each operator and define a unique identifier for each operator. Radio ID set in
this window must correspond to the value set in the Device ID field for the preconfigured
radioserver device in the Radio Management application (see the Capacity Max Systems
settings, viewed by the Subscriber Access Control value).

To open the Capacity Max System settings in the Radio Management application, click Action El
— Manage — Capacity Max System Server Data or press Ctrl+Alt+S.

& Radic Management - [m} >

e

Capacity Max System Server Data » Subscrib..s Control

Capacity Max Systems .
e et Wiew by: ®| Subscriber Access Control Talkgroup Site Association

C) @ = Q-

Device Type = Radio Alias B | Serial Number = Physical Serial Number

Systeml

+  DeviceID ¥ | Enabled on System = ju

Console 4000009

4000004

Console

Console 4000010

Interface: The IP address of the computer where SmartPTT Radioserver is installed.

Trunking Controller: Select to allow the connection to Trunking Controllers.

MNIS Data Gateway: Select to allow a connection to a MINIS Data Gateway and its use.
MNIS VRC Gateways: Select to allow a connection to a MINIS VRC Gateway and its use.
Allow transmit interrupt: Select if you want to interrupt a radio.

Prioritize calls during emergency: Sets a priority of the dispatcher call during the Emergency
Call. If the check box is selected, the dispatcher call has the highest priority during the Emergency
Call in relation to other calls and interrupts them in case of lack of resources.

Encrypted connection: Select to activate encrypted TLS connection between radioserver and
voice gateway.
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Channel Grant Waiting timer (s): Time period in seconds during which the caller expects a
response from the called party (the FOACSU strategy). It is recommended to use the default value
of 15 seconds that is set in Radio Management (see the Capacity Max Systems.... settings in the
Capacity Max Features menu of the CMSS configuration, the Channel Grant Waiting timer field
in the Timers tab).

NOTE

To open the Capacity Max Features of the of the CMSS configuration in the Radio
Management application, click Action EI — Manage — Configurations or press Alt+C. In the
open table, select the CMSS configuration and click Edit . In the open Set Categories pane,
expand Configuration:<CMSS configuration name> and select Capacity Max Features.

& Radio Management - O X
m
Configuration View P CMSS01 P Capacity Max Systems P Systeml
Set Categories 1

Save Az Close

v & Configuration: CMS501
B Device Information: USES1OPLXA General  Authentication  Timers  Capacity Max Sites  Adjacent Sites  Site Announcement

v [ Capacity Max Features
Capacity Max Systems: CapacityMaxSystem
Capacity Max Site Selection: VoiceMNISSite

User Name Verification Application

. -
~ ) Timers
D CMS5 Network: Network-101
Channel Grant Waiting Timer (sec) |15
» [ MNIS
> D Eridge Response Waiting Timer {sec) | 4.0

Group Call Hang Time (sec) |2

00 oo oojoD

Private Call Hang Time (sec) |4

FOACSU (Full Off Air Call Set Up) stands for the strategy of assigning the traffic channel only when
the called party user answered the call specifically. During the timeout the traffic channel is not
allocated for the call.
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For the correct work of the FOACSU private calls, ensure it is configured in Radio Management

(see the Capacity Max Systems:.... settings in the Capacity Max Features menu of the CMSS
configuration, the Individual Voice Call Type field in the General tab).

E Radio Management

£l BT/ T

Configuration View » CMSS01 » Capacity Max Systems P Systeml

Set Categories 1

Save Az Close

v [F] Configuration: CMS501
H Device Information: USES19PLXA General  Data Revert  Authentication  Timers  Channel Plan Lists  Capacity Max Sites
v [ Capacity Max Features

Capacity Max Systems: CapacityMaxSystem

~) General B
Capacity Max Site Selection: VoiceMNISSite
System Mame | Systernl
D CMSS Metwork: Network-101
C ity b .
» ] MAIS System Type | Capacity Max Advantage n
» [ Bridge Metwork Model | Large n
NetworkD |1
Individual Veice Call Type | FOACSU n |

TX time-out timer (s): Time period during which the radio can transmit without interruptions.
After this time is over, the transmission is interrupted. We recommend you to use the default
value of 60 seconds, which is set in Radio Management (see the MNIS System settings in the
MNIS menu of the CMSS configuration, the Transmission TOT field in the General tab).

NOTE
To open the MNIS menu of the CMSS configuration in the Radio Management application,
click Action E1 — Manage — Configurations or press Alt+C. In the open table, select the

CMSS configuration and click Edit . In the open Set Categories pane, expand Configuration:
<CMSS configuration name> and select MNIS — MNIS System.

[ Radio Management - [m] X

e

Configuration View P CMSS01 P MNIS System P MNISSystem-101

Set Categories 1

Close
hd E Configuration: CMSS01

E Device Information: USES19PLXA General

» [ Capacity Max Features

» O s SetName | MNISSystem-101
D MNIS System: MMISSystemn-101 {3
Last Modified Date  11/03/2016 13:35:06
D MMIS Networks MNISMetwork-101
» [ Bridge Comments

~ General

WRC Gateway Enable ||
MNIS Gateway UDP Port | 50000

Transmission TOT (sec) |60

Active Voice Talkpath Limit | 20

oo|oojoo
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GPS Transmission Mode: Select the suitable mode:

+ Data: GPS coordinates will be received in several packets. This mode is working only if
Trunking channel is set in Radio Management. However, traffic is consumed in this mode.

E Radio Management

El BT/ T

Configuration View » 478IRC0016 P Capacity Max Systems P TWVZSysteml

Set Categories 1
Save As Close
v [F Configuration: 478IRC0016
H Device Information: 478IRCO016
» [ General

v [ Capacity Max Features

General Data Revert  Authentication  Timers  Channel Plan Lists  Capacity Max Sites

Capacity Max Systems: CapacityMaxSystem 1 items found (1 currently selected).

> Ij Zone/Channel Assignment

~ ) Data Revert

| Enhanced GNSS Window Size | 10 n |

+ Enhanced CSBK: GPS coordinates will be sent as a single Control Signaling Block. This is

traffic-effective option and it allows to increase GPS request rate up to 7.5 s. However, you
should make sure that radio units in your system support CSBK commands.

1.2 Configuring Trunk Controller

Trunking controller of the Capacity Max network provides actual information about the network
status (registered radios).

NOTE

To configure trunk controller, install the corresponding license. For more information on how
to install licenses, see Licenses.
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To configure a primary trunking controller, follow these steps:
1. Ensure trunking controller is configured by using the Radio Management application, in

particular, you can obtain IP address and port from the Presence Server IP field.

NOTE

For more information on how to configure Radio Management application, see Motorola Radio
Management User Guide.

E Radio Management

= BT/ T

Configuration View » CMSS501 » CMSS Network ® Network-101

Set Categories 1

Close
v [F] Configuration: CMS501
H Device Information: USES19PLXA General
v [ Capacity Max Features
Capacity Max Systems: CapacityMaxSystem

Capacity Max Site Selection: VoiceMNISSite

~) General B

i Trunking Controller Enable [+
[ [ CMSS Network: Network-101 4 | avsstp (192020 |
> MNIS
= CMSS UDP Part | 50000 |
» [ Bridge

Trunking Controller IP 192.0.2.1:50000

| Presence Server I 192.0.2.1:50015 |

VRC Gateway /P 192.0.2.4

System Advisor IP 192.0.2.5

2.  Add a new Capacity Max network or select the existing one.

3. Inthe Capacity Max System pane, select the Trunking Controller check box to make
trunking controller settings available.

@ SmartPTT Server Configuration - C\Program Files (x88)\5martPTT\Server\RadioService.exe.config

Settings Metworks  (Client Lit  Rules  Activity Log  Export/lmport Settings  Statistics

- Control Stations
g Connect Plus

Capacity Max System

g NAI Systems Active
[—]H Capacity Max Metwors
E‘h Capacity Max 1 Name: |CEIDE|Ci‘h" Mae 1

Trunking Controller )
.8, MNIS Data Gateway Network ID:
{ gy MNIS VRC Gateway 1
h Talkgroups Interface: Aty “
L2 Security Settings

a8 SIP/RTP Interfaces "J”k“"g Controller

.. SmartPTT Radioservers MNIS Data Gateway

MNI5 VRC Gateways
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4. Inthe left pane, select Trunking Controller and in the Trunking Controller pane

replace the default text “remotehost:50075” in the Primary controller (IP address:Port)

field with IP address and port of the Presence Server from the Radio Management

application.
& SmartPTT Server Configuration - C\Program Files (x86)\5martPTT\Server\RadioService.exe.config — O X
Settings Metworks  (Client Lit Rules  Activity Log Export/Import Settings  Statistics

:. Contral Stations

g Connect Plus

g MAI Systems

-y Capacity Max Networks
-y Capacity Max 1

i B MNIS Data Gateway
El-ig MNIS VRC Gateways
: h MHMIS VRC Gateway 1
B Talkgroups

i E‘ﬁ Security Settings
g SIP/RTP Interfaces

Trunking Controller

Primary controller (IP Address:Port)

|remotehost 50015

Redundant controllers

Add

MName

| bl

IP Address:Port

Capacity Max supports up to 4 redundant trunking controllers to keep the radios online when the

primary controller goes offline. The order of redundancy is defined by the settings in the Radio

Management application.
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To configure additional trunking controllers:

1. Make sure that redundant trunking controllers are configured in the Radio Management

application.

E Radio Management

AE

Configuration View ® CMS501 * Capacity Max Systems » TVZSysteml

Set Categories 1

v & Configuration: CMS501
H Device Information: USES1OPLXA
v Capacity Max Features
[ Capacity Max Systems: CapacityMaxSystem
Capacity Max Site Selection: VoiceMNISSite
[M €M5S Metwork: Network-101
» [ mNIs
» [ Bridge

4 b

Save As

General  Authentication  Timers  Capacity Max Sites  Adjacent Sites

User Name Verification Application

Site Announcement

Primary Trunking Centroller IP

Primary Trunking Controller UDP Port | 50000

Call Moniter Application 1IP

Call Moniter Application 1 UDP Port | 51112

Call Moniter Application 2 IP

Call Moniter Application 2 UDP Port | 51112

Call Monitor Application 3 1P

Call Moniter Application 3 UDP Port | 51112

[192.021 |
|
[192.0.255 |
2
|0.0.00 |
|
[oo00 |
| a

Voice Interrupt Support
Telephone Support

2. Inyour Capacity Max network select Trunking controller.

Cloze

3. Inthe Redundant controllers area, click Add to add a new controller to the table.

Settings Metworks  (Client List  Rules  Activity Log

Export/Import Settings

@ SmartPTT Server Configuration - C\Program Files (x88)\5martPTT\Server\RadioService.exe.config

Statistics

- O

-t Control Stations

ﬁ Connect Plus

g NAI Systems

Sy Capacity Max Networks
Elh' Capacity Max 1

. MNIS Data Gateway
- g MNIS VRC Gateways
Talkgroups

i T Security Settings
ﬁ SIP/RTP Interfaces

Trunking Controller

Primary controller (IP Address:Port) |152-112-1 50015
Redundart controllers
Add Femove i Up ¥ Down
Name IP Address:Port
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4.  Change the redundant controller IP address and port according to the settings in the

Radio Management application. Rename the controller if needed. You should name

controllers differently.

Settings Metworks (Client List Rules

Activity Log

& SmartPTT Server Configuration - C\Program Files (x86)\5martPTT\Server\RadioService.exe.config — O X

Export/Import Settings  Statistics

ﬂ; Control Stations
g Connect Plus
g MAI Systems
-y Capacity Max Networks
Bh Capacity Max 1

B | Trunking Controller |
i Gl MNIS Data Gateway
h MNIS VRC Gateways
ji Talkgroups
St Securnty Settings
g SIP/RTP Interfaces

Trunking Controller

Primary cortroller {IP Address:Port)
Redundant controllers

Add Remove

MName

Redundant controller 1

[192.0.2.1:50015

| v

IP Address:Port

remotehost:50015

5.  Add more redundant controllers if needed. Change their IP addresses and ports according

to the settings in the Radio Management application.

NOTE

If ports of some controllers are the same, the exclamation mark @ appears near them. You

cannot switch to another menu until you change the ports.

You can change the order of the redundant controllers in the table. This helps to assign a new

active controller in case when others disconnect from each other.

To change the order of the controllers in the table, follow these steps:

1. Select the desired redundant controller.

SmartPTT PLUS
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2.  Click Up or Down to move the redundant controller up and down.

@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config

— O ot
Settings Metworks  (Client List  Rules  Activity Log  Export/lmport Settings  Statistics
ol i .
-+ Control Stations Trunking Controller
ﬁ Connect Plus
ﬁ MAl Systems
-y Capacity Max Networks Primary cortroller (IP Address:Port) |'|92.ﬂ.2.'| 50015 |
E‘h‘ Capacity Max 1 Redundant controllers
h Trunking Controller = =
_____ & MNIS Data Gateway Add || Remove | | # Up || # Down |
h MNIS VRC Gateways Name IP Address:Port
Talkgroups
i T Security Settings Fedundant contraller 1 152 0.2 1:50016

g SIP/RTP Interfaces

Redundant contraller 2 152 0.2 1:50017

Fedundant controller 3 15202 1:50018

To delete a redundant trunking controller from the table, follow these steps:

1. Inyour Capacity Max network select Trunking Controller.

2. In the Redundant Controller area, in the table select a redundant controller and click

Remove.

@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadicService.exe.config

— O o
Settings Metworks  (Client List  Rules  Activity Log  Export/lmport Settings  Statistics
L i .
g Control Stations Trunking Controller
ﬁ Connect Plus
ﬁ MAl Systems
Elg Capacity Max Networks Primany cortroller {IP Address:Fort) |'|52-ﬂ-2-'| 50015 |
E‘h‘ Capacity Max 1 Redundant cortrollers
h- Trunking Contraller = -
g8, MNIS Data Gateway pdd || Remove | | #Up || #Down |
g MNIS VRC Gateways Name IP Address:Port
Talkgroups
i T Security Settings Redundant controller 1 152.0.21:50016
W SIP/RTP Interfaces

Redundant controller 2 152.0.2.1:50017

Redundant controller 3 152.0.21:50018
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1.3 Configuring MNIS Data Gateway

To configure data transfer over Capacity Max network, configure MNIS Data Gateway settings in
SmartPTT Radioserver Configurator and in MOTOTRBO Network Interface Service Configuration
Utility.

NOTE
To configure data transfer, install the corresponding license. For more information on how to
install licenses, see Licenses.

To configure MNIS Data Gateway settings in SmartPTT Radioserver, click Capacity Max
Networks — Capacity Max — MNIS Data Gateway.

& SmartPTT Server Configuration - C\Program Files (x86)\5martPTT\Server\RadioService.exe.config — O X

Settings  Metworks (Client List Metwors Corfiguration Rules  Activity Log Export/Import Settings  Statistics

-~ Control Stations MNIS Data Gateway
g Connect Plus
H MAI Systems Socket Type Local Socket ~
9: &ngg;z’ﬁri*:'m Interface 192.168.56.1 v
g Trunking Controller MNIS Control Interface loopback:55000
=% - 4 MNIS Data Gateway -
g MNIS VRC Gateways MNIS ID 1 .
..... B Talkgroups Location Port 4001 B
e .TI'E Security Settings
H" SIP/RTP Interfaces TMS Part 4007 =
Telemetry Port 4002 =
Redundant MMIS data gateway
Socket Type Remote Socket w

MNIS Cortrol Interface (IP Address:Port} [loopback:55001 |

MNIS Relay Address (IP AddressPort) |remotehost:2850 |

Location Port 4011 =
TMS Port 407 =
Telemetry Port 4018 =

NOTE
The Data transmission check box in the Capacity Max window should be selected.
Otherwise, the MNIS Data Gateway parameter will not be shown.

Socket Type: Defines the software interface type to enable communication between processes.
Select the Local Socket value if the MOTOTRBO Network Interface Service Configuration Utility is
installed on the same computer as SmartPTT Radioserver. Select Remote Socket if the MOTOTRBO

SmartPTT PLUS Capacity Max Configuration Guide
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Network Interface Service Configuration Utility and SmartPTT Radioserver are installed on different
computers. In this case, information exchange between the processes is supported by the MNIS
Relay application.

Interface: MNIS interface. It must match the interface specified in the Radio Management
application (see the MNIS System settings in the MNIS menu of the DataMNIS_Config
configuration, the Gateway Tunnel IP field in the Tunnel Network tab).

[ Radio Management - [m] X

Configuration View P DataMNISOL P MNIS Systemn P MNISSystem-102

Set Categories 1

Close

v 'E]‘ Configuration: DataMNIS0L
H Device Information: DATAMNIS01 General  Tunnel Network  Location Radio ID Range List
» [] Capacity Max Features

v O s ~) Tunnel Network
D MNIS Security: MMISSecurity-101

| [ MNIS System: MNISSystem-102 43 |

[B MNIS Advanced: MNISAdvanced-102 Gatewsy Tunnel /P 192.168.10.7

Gateway IP | 192.168.10.1
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MNIS Control Interface: Use localhost, if MOTOTRBO Network Interface Service Configuration
Utility is installed on the same computer as the radioserver. If MOTOTRBO Network Interface

Service Configuration Utility and the radioserver are installed on different computers, enter the IP
address of the computer where MOTOTRBO Network Interface Service Configuration Utility is
installed. The port should match the port number specified in the Radio Management application
(see the MNIS Network settings in the MNIS menu of the DataMNIS_Config configuration, the
Control Interface TCP Port field in the General tab).

[ Radio Management - [m] X

e

Configuration View P DataMNISOL P MNIS Metwork P MNISNetwork-102

Set Categories 1

v 'E]‘ Configuration: DataMNISOL

H Device Information: DATAMNIS01 General
» [ Capacity Max Features
v [ MNIs TMS UDP Port | 4007 -
D MNIS Security: MNISSecurity-101 Telemetry UDE Bort | 4008 g
A ystem: System-102 -
[0 MNIS System: MNISSystem-10 Location Server UDP Port | 4001
D MMNIS Advanced: MNISAdvanced-102 o
User Defined UDP Port 1 |0 - Disabled I~
D MNIS Network: MMISMetwork-102  £3% =
B MNIS Forwarding Rules User Defined UDP Port 2 |0 - Disabled
D) MINES Application Ouerride Rules User Defined UDP Port 3 |0 - Disabled g
[ MNIS Sites: MMISSitesList-101 XCMP High Efficiency Data Enable
XCMP Server UDP Port 4004
Battery Management UDP Port | 4009
Control Interface TCP Port | 55000 g]
Job Ticket UDP Port | 4013
4 » -

NOTE

To open the MNIS menu of the DataMNIS configuration in the Radio Management application,
click Action E1 - Manage — Configurations or press Alt+C. In the open table, select the
DataMNIS and click Edit. In the Set Categories pane that opened, click Configuration:
<DataMNIS name> — MNIS.
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MNIS ID: The Common Air Interface (CAI) ID of the MNIS in the radio network. The ID is used by
other calling radios when addressing MOTOTRBO Network Interface Service Configuration Utility.

Verify MNIS ID matches the corresponding field in the Radio Management application (see the
MNIS System settings in the MNIS menu of the DataMNIS configuration, the Data Gateway
Radio ID field in the General tab).

[ Radio Management - O X

Configuration View » DataMMNISOL » MNIS System P MNISSystem-102

Set Categories 1

Close

hd E Configuration: DataMNIS01
H Device Information: DATAMNISO1 General  Tunnel Network  Location Radio ID Range List

» O] Capacity Max Features

v [ MNIs ~) General |
D MNIS Security: MNISSecurity-101
D MNIS System: MMISSystem-102 43¢
D MNIS Advanced: MNISAdvanced-102
D MMIS Network: MNISMetwork-102

Data Gateway Radio ID | 300

MNIS Gateway UDP Port | 50000
Enhanced Data Enabled [+

Bloco oojoo|

D MNIS Forwarding Rules Data Gateway Queue Size | 25
D MNIS Application Override Rules TX Privacy Type | Mone
D MMIS Sites: MMNISSitesList-101 TX Frivacy Afias  None

Location Port: The port where the radioserver will expect GPS data.
TMS Port: The port where the radioserver will expect text messages.
Telemetry Port: The port where the radioserver will expect telemetry data.

The ports should match the ports set in the corresponding fields in the Radio Management
application (see the MNIS Network settings in the MNIS menu of the DataMNIS configuration,
the Location Server UDP Port field, the TMS UDP Port field, the Telemetry UDP Port field in
the General tab).

[ Radio Management - [m] X

Configuration View » DataMMNISOL » MNIS Metwork ® MNISNetwork-102

Set Categories 1

Cloze

hd E Configuration: DataMNIS01
H Device Information: DATAMNISO1 General
» [ Capacity Max Features
* [ MNIs
D MNIS Security: MNISSecurity-101
D MNIS System: MMISSystem-102
D MMIS Advanced: MNISAdvanced-102
D MMIS Metwork: MNISNetwork-102 {3} User Defined UDP Port 1 |0 - Disabled

TMS UDP Port | 4007

Telemetry UDP Port | 4008

Location Server UDP Port | 4001

<[> <] >N <] H<]
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To set up MNIS Data Gateway settings in the MOTOTRBO Network Interface Service Configuration

Utility, follow these steps:

1. Save MNIS Data Gateway settings from the Radio Management application as GWCFGX
file. For that, click Radios, right click the DATA MNIS... item in the table that opened and
click Export — GWCFGX... or press Ctrl+Shift+N. In the open Export GWCFGX window,

select the file and click OK.

E Radio Management

Show Details..

Edit Configuration... Aralyze

Radio View
Groups 1
Infrastructure / @ @ @ El’ E",
Radios
Serial Number Radio Alias Configura
Repeaters
USESIGRLYA Matarcla CMSS01
| DATANMNISOT Maotorola DatalNISi
MXQE2407XL Matarcla CMES0Z

1 —
3 items found (1 currently selected).

Analyze ResuII3| |Compare Results| Tasks(2*)
COMNNECTED TC: LOCALHOST

Copy

Show Details...
Delete

Select Group...

Edit Canfiguration...
Select Configuration...

Compare

Package

Upgrade Language Pack

Export
Modify Radio Password.
Copy Identity

Ctrl+C mware Version

Codeplug Version Job Statu
Ctrl+V 3.00.00 Completec
02.00.00
Ctrl+W J3.00.00 Completec
Del
Ctrl+Alt+G
Ctrl+F
Alt+5Shift+F
b
Cirl+ ]
Alt+Shift
Allt+Shift
Alt+Shift+5
Ctrl+l
’ Radio... Ctrl+Shift+R
Grid to File... Ctrl+Shift+S
| GWCFGX... Ctrl+Shift+N |

SmartPTT PLUS
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2. Transfer the saved GWCFGX file to your computer where the MOTOTRBO Network Interface
Service Configuration Utility is installed, to the Config folder that is located on the local

disk C:/ProgramData/Motorola/Wireline Gateway.

3.  Launch the MOTOTRBO Network Interface Service Configuration Utility and
click Configuration — Select Active Configuration. In the Select Configuration
window that opened, select the GWCFGX file saved before and click OK.

N MOTOTRBO Metwork Interface Service Configuration Utility — O et

Configuration  View  Edit  Service  Help

O = 0@

Lt Select Configuration

Select Configuration

CapacityMagwchgx

If MOTOTRBO Network Interface Service Configuration Utility and the SmartPTT Radioserver are
running on different computers, or you configure several MNIS Data Gateways, follow these
steps:

1. Install and run MNIS Data Gateway Relay on the computer where MOTOTRBO Network
Interface Service Configuration Utility is running.

2. Runthe MNIS Data Gateway Relay Configurator.

%) MNIS Data Gateway Relay — >
MMIS intefface: | 192.168.1.1 w
Serverinterface: | 192.168.1.1 | Pott |3890 =
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3. In the MNIS interface field enter the same address as it is in the Tunnel IP Address of

MNIS.

4. Inthe Server interface field enter the same address as you did in the previous step.

5. Inthe Port type the available port of the computer.

6. Save changes and restart MNIS Data Gateway Relay.

7. InSmartPTT Radioserver Configurator double-click your network and click MNIS Data

Gateway.

Settings Metworks  Client List  Rules

Activity Log BExport/Import Settings  Statistics

@ SmartPTT Server Configuration - C\Program Files (x88)\SmartPTT\Server\RadioService.exe.config

~ge> Control Stations

-y Connect Plus

g MNAI Systems

-y Capacity Max Networks
-y Capacity Max 1

h Trunking Controller

- Ty
: & Talkgroups

i ?ﬁ Security Settings
g SIP/RTP Interfaces

MNIS Data Gateway
Socket Type
MMIS Control Interface
MMIS Relay Address
MMIS 1D
Location Port
TMS Port
Telemetry Part
[ Redundart MMNIS data gateway

8. Inthe Socket Type field select Remote Socket.

9. Inthe MNIS Control Interface field, enter the IP address of the computer where MNIS
service is running and the port from the MNIS Control Interface TCP Port field of the
MOTOTRBO Network Interface Service Configuration Utility.

Remote Socket

| 152.168.2.2:55000

192.168.2.2:3830

] -
4001 =
4007 =
4008 =

Remote Socket

loopbachk : 55000
remotehost:2850
4011 =
4017 =

4018 =
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10. Inthe MNIS Relay Address field, enter the IP address of the computer where MNIS Data
Gateway Relay service is running and the port from the Port field of MNIS Data Gateway

Relay.
11. Configure other settings as describer previously.
12. Click Save [= to save changes.

13. Click Restart [@] to restart SmartPTT Radioserver and apply changes.

1.4 Configuring MNIS VRC Gateway

Every Capacity Max network supports up to 15 MNIS VRC gateways. The first gateway is created
always exists in the network, so you can add 14 gateways more.

NOTE
To configure MNIS VRC gateway, install the corresponding license. For more information on
how to install licenses, see Licenses.

The order of the gateways matters a lot. All newly created profiles and talkgroups for your
Capacity Max network will be assigned for the first MNIS VRC Gateway in the list. Therefore, you
should be careful when configure several MNIS VRC Gateways.

To configure MNIS VRC gateway, follow these steps:
1. Make sure that VRC Gateway is configured in the Radio Management.

NOTE
For more information on how to configure Radio Management application, see Motorola Radio
Management User Guide.
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2.

In your Capacity Max network select MNIS VRC Gateways to show and allow to

configure MNIS VRC Gateways.

@ SmartPTT Server Configuration - C:\Program Files (x26)45SmartPTT\Server\RadicService.exe.config — O x>
Settings Metworks  Client List Rules  Activity Log  Bxport/Import Settings  Statistics
----- % Control Stations Capacity Max System
g Connect Plus _
-y MNAI Systems Active
[—j--H Capacity Max Metworks
(=B =] Capacity Max 1 MName: |C.apac'rt:.f Max 1
Trunking Controller )
88, MNIS Data Gateway Network ID:
i iy MNIS VRC Gateway 1
Talkgroups Interface: .Iqﬂj" e
Ltgt Securty Settings
-l SIP/RTP Interfaces Tiunking Cortrolier
----- BN SmartPTT Radioservers MNIS Data Gateway
MNIS VRC Gateways
Data Transmizsion Options
GP5 transmission mode: Data ~
Yoice Transmission Options
[J Alow transmit intemupt
[] Pricritize calls during emergency
[] Encrypted connection
Channel Grant Waiting timer (g} 15 =
T time-out timer (s): 60 =
3. Toadd a new MNIS VRC Gateway right-click MNIS VRC Gateway and click Add.
@ SmartPTT Server Configuration - C:\Program Files (x88)\SmartPTT\Server\RadioService.exe.config — O et
Settings Metworks  (Client List  Rules  Activity Log  Export/lmport Settings  Statistics
-z Control Stations MNIS VRC Gateways
-y Connect Plus
ﬁ NAIl Systems
[—]ﬁ Capacity Max Metwors
ah Capacity Max 1
& MNIS Data Gateway
h- MNIS VRC Gateways
Talkgroups Add
L.zt Securty Settings .
g SIP/RTP Interfaces

4.

Select the newly created or existing gateway.
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NOTE
By default, all new gateways obtain equal IP addresses and ports. When you select one of

those, you will not be able to leave the menu until you make its IP address and port unique

within the site.

5.  Configure the gateway options.

%) SmartPTT Server Configuration - C\Program Files (xB8)\5martPTT\5erver'\RadioService.exe.config - O >

Settings Metworks  Client List Rules  Activity Log Export/Import Settings  Statistics

""" Ei' g”mmf;:m”s MNIS VRC Gateway
----- onnect Plus
----- H’ MAl Systems N
-y Capacity Max Networks ame ||""”“”S VRC Gateway 1 |
E|h Capacity f_*ﬂa?"- 1 Primary gateway address and port |remotehnst:EEDDD |
o h Trunking Cantroller Redundant gateway address and | |
----- B MNIS Data Gateway port
Elh EN_ICw 1 Woice port Jocal) 40000 =

é% ;—alkgr'i-::gzﬂ_ Recording of voice calls between radios
bt Secu ings

----- H SIP/RTP Intefaces
B9 SmatPTT Radioservers

Bxample: 1-59, 150
Radio 1Ds far voice calls recording |.|_1 ET76415 |

Telephone calls
Bample: 1-53, 150

Radio 1Ds for phone calls |.|_1 ET7E415 |
Talkpaths {1)
(® Private (1) () Group (0)
Active Mame ]

Defautt radio ID 1

Name: The name of the gateway in SmartPTT Radioserver Configurator. Rename your gateway if

needed.

Primary gateway address and port: IP address from VRC Gateway IP and port from Server
TCP port which were configured in your CMSS Network in Radio Management.

Redundant gateway address and port: IP address of VRC Gateway IP and port from Server
TPC port of the additional CMS server you assign to be redundant. You can leave this field empty
if you do not have redundant VRC gateway.

Voice port (local): The port at which SmartPTT Radioserver will expect the voice data.

Recording of voice calls between radios: Select this to activate voice recording feature, that
allows the dispatcher to hear private calls made from radios to other radios, dispatchers or
telephone subscribers.
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Radio IDs for voice call recording: Enter radio IDs for which the recording should be active.
Follow the example, to specify the IDs.

Phone calls: Select this if you want to allow telephone calls for this gateway.

Radio IDs for phone calls: Enter radio IDs for which phone calls should be available. Follow the
examples, to specify the IDs.

Talk paths: You can reorganize the default gateway for radios and profiles here.

Private: Click this to view the radio profiles which assigned to the current gateway. Profiles can
be assigned to the gateway (Active is selected), not assigned (Active is clear) and unavailable on
it (Active is clear, profile name is discolored). If the profile is unavailable, it means that it is
selected on the other gateway. By default all new profiles will be selected on the first gateway in
the list and their ID will be the same as that of the first gateway in the list.

Group: Select this to view talkgroups created for the current site. For more information see
Capacity Max Talkgroups.
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1.5 Configuring Talkgroups

To configure Capacity Max talkgroups, click Talkgroups. The Control Station Talkgroups
window appears:

@ SmartPTT Server Configuration - C\Program Files (x88)\5martPTT\Server\RadioService.exe.config — O et
Settings Metworks  (Client Lit  Rules  Activity Log  Export/lmport Settings  Statistics

-~ Control Stations Control Station Talkgroups

H’ Connect Plus

H" MNAI S:.fstems Ter

Sy Capacity Max Networks
St Capacity Max 1
h All Call
i@l MNIS Data Gateway
S MNIS VRC Gateways Add Remove _ S
h MNIS VRC Gateway 1 MName ] Site Mumber Voice gateway
M Tokrouos . _
semm CON [ [wswon -

g SIP/RTP Interfaces Group 2 z Viide ~ |MNIS VRC Gate... |~
Group 3 3 Wide ~ |MNIS VRC Gate... |~
Group 4 4 Wide ~ |MNIS VRC Gate... |~
Group 5 5 Wide ~ | MNIS VRC Gate... |~
Group & 6 Wide ~ | MNIS VRC Gate... |~
Group 7 7 Wide ~ | MNIS VRC Gate... |~
Group 8 8 Wide ~ | MNIS VRC Gate... |~
Group 5 5 Wide ~ | MNIS VRC Gate... |~
Group 10 10 Wide ~ | MNIS VRC Gate... |~

To add a talkgroup, click Add. To add an All Call, click All Call. The added talkgroups will also
appear in the Profiles window. To change the order of groups in the list, use the Up and Down
arrows. The order defined in the window will be used in SmartPTT Dispatcher. To copy added
groups to the clipboard, click Copy. To paste copied groups from the clipboard, click Paste. To
delete the selected talkgroup, click Remove.

Name: Talkgroup alias displayed by the control station.

ID: Talkgroup unique identifier used during communications. To be set in the range from 1
to 65535 for a talkgroup, and in the ranges from 1 to 16776415, from 16777056 to 16777183 or
be equal to 16777214 for an All Call.

To edit the talkgroup name or ID, set the cursor on the corresponding field and make changes.

Site Number: Site number list allowed for transmitting. In the Capacity Max network the
talkgroups can be only wide-area, while All Call can be wide-area or local.
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NOTE
In the Capacity Max network you can add only wide-area talkgroups, so only the Wide value is

available for groups in the Site Number field. In order to display wide area talkgroups in
SmartPTT Dispatcher, add necessary talkgroups in SmartPTT Radioserver Configurator, define
talkgroup identifiers that correspond to the identifiers of the wide-area talkgroups in the Radio
Management settings. You can add a wide-area All Call and a local All Call, which is limited to
one site. To add a wide-area All Call, which is available to all sites, click All Call. Verify that Site
Number is set to Wide. To add an All Call limited to one site, click All Call, and in the Site
Number field select the site number where the All Call will be heard. Please note, that you do
not need any IDs for All Calls.

Voice gateway: List of available voice gateways. You can assign a certain voice gateway for each
talkgroup.

NOTE

If there are some available voice gateways, all talkgroups use by default the first voice gateway
in the list. If the talkgroup is not registered on any voice gateway, the Voice gateway field will
be empty. If Voice transmission is not selected in the Capacity Max network settings, the Voice
gateway column will be hidden.

You should create talkgroups in accordance with the settings in the Radio Management
application (see the Capacity Max Systems settings, sorted by the Talkgroup Site Association
value). For more information, see Motorola Radio Management User Guide.

1.6 Security Settings

Capacity Max network supports two types of privacy mechanisms - Enhanced and Advanced
Encryption Standard (AES).

The Enhanced Privacy utilizes Motorola proprietary algorithms and therefore is not interoperable
with other vendor's privacy offerings. The Enhanced Privacy provides high level of protection by
means of 40-bit key length and supports multiple keys in a radio.

The Advanced Encryption Standard (AES) is a specification for the encryption of electronic data
established by the U.S. National Institute of Standards and Technology (NIST). The AES feature
supports 256-bit key length, unlike Enhanced Privacy. Similar to Enhanced Privacy, the AES also
supports multiple keys. For AES encryption a special license is required.
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You can specify the encryption keys for incoming and outgoing traffic on the digital channel in the

Security Settings window.

Settings Metworks  (Client List Rules

Activity Log

@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadicService.exe.config - O X

Export/Import Settings  Statistics

i, Contral Stations

g Connect Plus

H MAI Systems

-y Capacity Max Networks
-y Capacity Max 1

iy Trunking Controller

...l MNIS Data Gateway

-4y MNIS VRC Gateways

-& Talkgroups
W] Coc ity Settings
g SIP/RTP Interfaces

-y MNIS VRC Gateway 1

Security Settings

Copy

Enhanced Privacy
Add Remaove

Key 1D Key Value

TX Privacy

Type | Mo | Key D

Copy: Copy encryption settings of the channel to the clipboard.

Paste: Paste encryption settings of the channel from the clipboard.

Enhanced Privacy

To configure Enhanced Privacy, follow these steps:

1. Run the Radio Management application.

2. Inthe Privacy Keys tab of the Radio Management application add the enhanced privacy

key. Enter its ID and value in the corresponding fields.

ﬂ Radic Management

Resource View P Privacy Keys

Firmware

Language Packs

Woice Announcements
Text To Speech Packs
Symmetric Keys

RAS Keys

Privacy Keys

Key IDx

R L e

Key Alias
Priv3
Privg
Priv8
Priv2

e e R

o -

Key Value | In-Use Templates and Sets = In-Use Templates{Template Mode) In-Use Sets{Configuration Mode) Com

1 0 1
1 0 1
1 0 1
g 0 g
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2. Open the configuration of the required radio station and in the Set Categories menu

click General — Security. To make the added enhanced privacy keys available for

selection, add them in the selection set. To do that, in the Privacy tab click the Add.

E Radio Management

A

Configuration View » B71TRREZ02Z » Security * Security-104

Set Categories 1
- 'E]‘ Configuration: 871TRRBI02 -
B Device Information: 871TRR8902

v ) General
D Welcome Bitmap: WelcomeBitmap-101
D Language Packs: PCRLanguage-104
D General Settings: GeneralSettings-104
D Accessories: Accessories-104
D Control Buttons: ControlButtons-104
D Text Messages: TextMessages-104

D Telemetry: Telemetry-104
[ Menu: Menu-104

[ D Security: Security-104 £ ]
D MNetwork: Network-104

Voice Announcement: VeiceAnnouncer

D Indoor Location: IndoorLocations-104 o

~) Privacy

General

Privacy

AES

Restricted Access to System

Close

Owver-the-Air Pregramming

Enhanced Privacy Keys

©

1
2
3

Key ID

Key Alias
PrivZ
Privl
Privd

1
1
i

Basic Privacy Key

Privacy Type | Enhanced ‘ I

Key Value
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3. Inthe Add Keys window, select the required keys, which you want to be available for
selection in the Privacy Alias field when specifying the enhanced key on the channel and
click OK.

Add Privacy Key X

M KeylD Key Alias Key Value = Comments

4 Priv3 2

1 items found (1 currently selected).

4. Inthe Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type
field select Enhanced.

B MOTOTRBO Customer Programming Software - [Sample.ctb] - O x
Fie Edt Miew Device Features Remote Window Help - 8 X

@) & M) d K & B B Q (oMM :|

RM | Open Save | Reports Delete | Cut Copy Paste | Search | Read Write Clone | Bluetooth

= filisi SLR 5500
General Setfings

- @ Accessories Top  Privacy  Restricted Access to System
e Security

£ I
Link Establishment
» Sites
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5. Inthe Security window of MOTOTRBO Network Interface Service Configuration Utility in
the Enhanced field add the enhanced privacy key. Enter its ID and value in the
corresponding fields.

{ MOTOTRBO Network Interface Service Configuration Utility * - m} x
Configuration  View  Edit  Service  Help
J ok H 0 e
= @ Untitled ~
Bl General
@ Security
- & Group List
- @4 Conventional
g eﬁﬂ.} Capacity Plus
1 < _' - Linked Capacity Plus Blias Key ID Key Value
B &8 Advanced .+ | Enhanced Key1 1 2612346782

Add Delete

6. Inthe Security Settings window of SmartPTT Radioserver Configurator add an enhanced
privacy key for incoming traffic. Enter its ID and value in the corresponding fields.

Erhanced Privacy
Add Remove

Key (D Key Value
1 0123456789

NOTE

Key ID and Key Value must match the values set in the radio settings in the Radio Management
program and MOTOTRBO Network Interface Service Configuration Utility. If the values in the Key
ID fields are the same, but the values in the Key Value fields do not match, the receiving side
hears only a distorted voice. If the key identifier of the transmitting side does not coincide with
one of the key identifiers in the list of the receiving side, then transfer to the receiving party will

not be heard.
7.  Click Save 5 to save changes.

8.  Click Restart [@]to restart SmartPTT Radioserver and apply changes.
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AES Privacy
To configure the AES privacy, follow these steps:
1. Run the Radio Management application.

2. Inthe Symmetric Keys tab of the Radio Management application add the AES privacy
key. Enter its ID and value in the corresponding fields.

[ Radio Management - [m] X

Resource View P Symmetric Keys

Resources 1
Firmware
Language Packs KeyID | KeyAlias = KeyValue | In-Use Templatesand Sets = In-Use Templates(Template Mode) = In-Use Sets(Configuration Mode)
Voice Announcements 1 Symil02 1 E a 3

Text To Speech Packs

| Symmetric Keys ‘

2. Open the configuration of the required radio station and in the Set Categories menu
click General — Security. To make the added AES privacy keys available for selection,
add them in the selection set. To do that, in the AES field, click Add.

[ Radio Management - [m] X

Configuration View » B71TRRE302 P Security P Security-104

Set Categories 1

Close

B DTS ShUiausL s s
v [ General
D ‘Welcome Bitmap: WelcomeBitmap-101
D Language Packs: PCRLanguage-104

a
General  Privacy  AES  Restricted Access to System  Ower-the-Air Programming

D General Settings: GeneralSettings-104 AES

D Accessories: Accessories-104 @
D Control Buttons: ControlButtons-104
D Text Messages: TextMessages-104 Key ID Key Alias Key Value

D Menu: Menu-104

D Telemetry: Telemetry-104 1 Symio? 1
[ D Security: Security-104 {8 l I
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3. Atthat the Add Keys window appears: Select the required keys, which you want to be
available for selection in the AES Alias field when specifying the AES privacy key on the
channel and click OK.

Add Privacy Key X

M KeylD Key Alias Key Value = Comments

4 Priv3 2

1 items found (1 currently selected).

4. Inthe Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type
field select Enhanced.

B MOTOTRBO Customer Programming Software - [Sample.ctb] - O x
Fie Edt Miew Device Features Remote Window Help - 8 X

@) & M) d K & B B Q (oMM :|

RM | Open Save | Reports Delete | Cut Copy Paste | Search | Read Write Clone | Bluetooth

= filisi SLR 5500
General Setfings

- @ Accessories Top  Privacy  Restricted Access to System
e Security

£ I
Link Establishment
» Sites
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5. Inthe Security window of MNIS in the Symmetric Keys area, add the AES symmetric
privacy key. Enter its ID and value in the corresponding fields.

{™ MOTOTRBO Network Interface Service Configuration Utility * = m} *

Configuration  View  Edit  Service  Help

Dbk ©C0O0 @
= @ Untitled ~
. EH General
[ Security
- #8 Group List
- #4 Conventional
& Capacty Plus
# <& Linked Capacity Plus Alias Key ID Key Value
W @R Advanced » | Symmetric Keyl K | 54634562435 |

Add Delete

6. Inthe radio settings in the Radio Management application to enable the AES encryption
mode on the required channel, clear the Privacy check box and in the AES Alias field
select the AES privacy key.

3 Radio Management O X
E E UA::? T
Configuration View b E71TRRE302 b Zone b CapMaxZons
Set Categories [l

Close
v [F] Configuration: 871TRR8302 =
B Device Information: 871TRRES02
> O General Zone Items
» [ Job Tickets
> O systems ® ]
» [ Encoder
» [ Decoder Position Set Name Channel Type Channel Name | Voice Announ: | Phone System | Privacy Privacy Alias | AES Alias
» O] Contacts s < Personality-460  Capacity Max Personality TG101Channel  Aone Syst 0 Privz Sym102
» [] RX Group Lists s 2 Personality-458  Capacity Max Personality TG102Channel e Syst O iz None
» [ Capacity Max Features s 3 Personality-458  Capacity Max Personality TC103Channel  None Syst ] Privz None
v [ Zone/Channel Assignment e 4 Personality-457  Capacity Max Personality TG104Channel  None Syst Priv2 Mone
v [0 Zone
o s 5 Personslity-456  Capacity Max Personality Enhanced Nene Sysi ] Priv2 None
@ ConnectPlus = =
s 6 Personality-455  Capacity Max Personality SiteAlCall Nena Syst Privz None
& CopMaZone 1
s 7 Personality-454  Capacity Max Personality MultiSiteAllCall  None Syst [ Priv2 Mone
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7. Inthe Security Settings window of SmartPTT Radioserver Configurator add an AES
privacy key for incoming traffic. Enter its ID and value in the corresponding fields.

AES
Add Remove

by (D Key Value
1 5876543210

NOTE

Key ID and Key Value must match the values set in the radio settings in the Radio Management
program and in MOTOTRBO Network Interface Service Configuration Utility. If the values in the
Key ID fields are the same, but the values in the Key Value fields do not match, the receiving
side hears only a distorted voice. If the key identifier of the transmitting side does not coincide
with one of the key identifiers in the list of the receiving side, then transfer to the receiving

party will not be heard.
8.  Click Save |5 to save changes.

9. C(Click Restart [@]to restart SmartPTT Radioserver and apply changes.

TX Privacy

TX Privacy is used for selecting an encryption mode for outgoing traffic on the side of SmartPTT

Dispatcher.
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To configure the TX Privacy for a Capacity Max system, follow these steps:

1. Inthe TX Privacy area, from the Type list select the desired encryption type:

) SmartPTT Server Configuration - C:\Program Files (x36)\SmartPTT\Server\RadioService.exe.config - O X

Settings Metworks  (Client List Rules  Activity Log Export/Import Settings  Statistics

g Control Stations Security Settings
.-y Connect Plus

my MAl Systems Copy
; H‘ Capacity Max Metworks
‘igw SIP/RTP Intefaces Basic Privacy

Key 1 S

Enhanced Privacy
Add Remove

Key ID Key Value

TX Privacy

Type Mo | | Key ID

+ Select No if encryption of outbound traffic from the radioserver is not required.

+ Select Enhanced if you want to use enhanced encryption for outgoing traffic from the
radioserver. Use the Key ID you specified in the Enhanced Privacy area.

» AES license is required: Select AES (Symmetric Key) if you want to use AES (Symmetric Key)
encryption for outgoing traffic from the radioserver. Use the Key ID you specified in the
AES area.

NOTE
If from the Type field No is selected and you have AES encryption for incoming traffic
configured, AES (Symmetric Key) is used for incoming traffic by default.

2.  Click Save |5 to save changes.

3. Click Restart [@]to restart SmartPTT Radioserver and apply changes.
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1.7 Adding Console in Radio Management

Radio Management dispatch console is used for providing a dispatcher with an access to the
Capacity Max network.

To add console in Radio Management, follow these steps:

1. Click Actions El, and select Manage —Capacity Max System Server Data.
2. Click Add @,

3. Inthe open Add Device window, from the Device Type list, select Console and click OK.

Add Device >
&

Device Type Conscle n

4. Inthetable, in the added console row, perform the following actions:
a. In the Device ID column, enter radio ID for the console.
b. Inthe Allowed Sites column, from the list select Edit.

i In the Allowed Sites Lists window, from the Allowed Site List Name, select

the desired site for registering.
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ii. Click Save.

] Allowed Sites Lists x
Allowed Site List Mame Available Selected
Al ites>
DataMNISSite31 DatabiNiE01 Add Al VoicaliNET
VoiceMNISSite36
Add
Allowed Sitel
Allowed Site2

Remove

Remowe All

1 items found (1 currently selected). 1 items found (1 currently selected).

Save Close

c. Inthe Telephone Gateway Site column, from the list select the desired site for

telephone recording.

d. Inthe Voice Recording Site column, from the list select the desired site for voice

recording.

E Radio Management

Capacity Max System Server Data » Subscrib..s Control

Capacity Max Systems . — —
B WView by: |®] Subscriber Access Contral || Talkgroup Site Association
TVZSysteml

® 1 Q-
Device Type P | DeviceID B Allowed Sites Telephone Gateway Site @ Voice Recording Site

Console 4000019 VoiceMMISSite35 ~ MNone ~ Mone - 0

Console 600 VoiceMMISSite36 > WoiceMMIS01 ¥ VoiceMNISO1 AN

Console 4000018 VoiceMMISSite36 T MNone ¥ DMone * 0

1.8 Configuring Joint GPS and Indoor Data

If you want to receive joint location data (GPS and indoor) in Capacity Max, configure the

following settings:
+ Radio settings in Radio Management

« Radio settings in SmartPTT Dispatcher
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Repeater settings in Radio Management

Capacity Max settings in Radio Management

1.8.1 Configuring Capacity Max in Radio Management

To configure Capacity Max in Radio Management, follow these steps:

1.

W

Click Actions EJ, and select Manage —Sets, or press Alt+S.

In the Set Categories pane, select Capacity Max features —Capacity Max Systems.
In the left column of the table, click * to select the desired Capacity Max system.

Click Edit ».

In the Data Revert tab, from the Enhanced GNSS Window Size list, select the value 70.

Save changes.

1.8.2 Configuring Repeater in Radio Management

To configure Capacity Max in Radio Management, follow these steps:

1.

Click Actions EJ, and select Manage —Sets, or press Alt+S.

In the Set Categories pane, select Capacity Max features —Capacity Max Systems.
In the left column of the table, click * to select the desired Capacity Max system.

Click Edit ».

In the Capacity Max Sites tab, perform the following actions:

a.  Inthe left column of the table, click * to select the desired Capacity Max system.
b.  Click Edit ~.

In the Capacity Max Channels tab, perform the following actions:

a. Intheleft column of the table, click * to select the desired Capacity Max system.
b.  Click Edit ~.

In the General tab, from the Channel Type list, select Data Revert Channel.

Save changes.
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1.8.3 Configuring Radio in Radio Management

To configure radio in Radio Management, follow these steps:

1.

Click Radio View H.

In the left column of the table, click * to select the desired radio.

Click Edit ~.

In the Set Categories pane, perform the following actions:

a. Expand Configuration — Zone/Channel Assignment — Zone.

b.  Select the desired Capacity Max zone.

In the left column of the table Zone Items, click > to select the desired channel.

Click Edit ».

In the General tab, from the Compressed UDP Data Header list, select DMR Standard.
In the RX/TX tab, clear the CSBK Data check box.

Save changes.

1.8.4 Configuring Radio in SmartPTT Dispatcher

To configure radio in SmartPTT Dispatcher, follow these steps:

1.
2.

Open the radio properties window.
In the Location tab, perform the following actions:
a.  Select the Indoor Tracking check box.

b.  Select the Update Interval check box, and enter 30 in the field.
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